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本章大綱&學習目標
 R軟體環境簡介

 R軟體安裝，R程式執行及套件(Package)
 R相關檔案其副檔名的意義
 求助說明 help()、內訂Demo程式

 R程式IDE編輯器: RStudio
 建立專案、HELP、常用快速鍵

 更新R軟體及R套件
 常用查詢指令: sessionInfo, .libPaths, R.Version, 

RStudio.Version, packageVersion
 R的學習資源
 安裝RStudio常見問題
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The R Project for Statistical Computing
http://www.r-project.org

Rgui
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R是什麼?
R is a language and environment for statistical computing and graphics.
 R 是一種程式語言與統計軟體環境，主要用於統計分析、資料探勘、機器學習與繪圖。
 它最早(1985)由紐西蘭奧克蘭大學的 Ross Ihaka 和 Robert Gentleman 開發（名字 R 就來自他們的名字

首字母）。
 R 有龐大的套件生態系（CRAN），研究人員、數據科學家和統計學家可以快速使用現成的套件做迴歸、

分類、時間序列、文字探勘等分析。
 R 在學術界和產業界都非常普及，尤其是在需要大量統計建模和資料視覺化的領域。
 簡單來說，R 就像是一個「專門為統計和資料分析打造的程式語言」，特別適合學術研究與數據處理。

R 語言應用地圖
 統計分析：迴歸、ANOVA、時間序列、貝葉斯模型
 資料視覺化：ggplot2、互動式圖表、儀表板
 機器學習：分類、分群、神經網路、隨機森林
 商業與經濟分析：行銷數據、財務風險、顧客分析
 生物資訊與醫學研究：基因資料、臨床試驗數據、生存分析
 文字探勘與自然語言處理：文字雲、情感分析、語料庫研究
 大數據與資料處理：SparkR、資料清理與轉換、大規模運算
 學術研究與教育：教學、教材開發、學術論文分析

優點:
• 免費統計分析軟體’完整的說明文件與討論區’ 高品質的學術繪圖’ 程式易根據需求修改
缺點:
• 不親切的使用者介面(Rgui)’ 需詳知套件、函式名稱與程式編寫邏輯’ 大量計算效能低。(已有改進方
法)’ its lack of security over the Web
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我為什麼要使用R做為資料分析工具?
http://www.r-project.org
https://posit.co/

寫程式是資料分析的必要技能
https://medium.com/datainpoint/9ee15b58cc
Python or R, what should you learn first?  
https://read01.com/0ePnyD.html#.Wu66C3--kZY
Why I use R for Data Science – An Ode to R
https://www.r-bloggers.com/why-i-use-r-for-data-science-an-ode-to-r-2/
選擇R開發數據分析平台的 4 個不錯的理由
https://read01.com/660M4g.html
做數據分析必須學R語言的4個理由
https://read01.com/yyREB2.html
Hadley Wickham：一個改變了R的人
https://read01.com/Mmy64J.html
Hadley Wickham: "R is ... tailored to 
the problems of data science"

Robert C. Gentleman
Department of Biostatistical Sciences, 

Dana Farber Cancer Institute

Ross Ihaka, 
University of Auckland, 2017
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TIOBE 全球程式語言排名

http://www.tiobe.com/tiobe-index/

(共243種程式語言)
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Vibe Coding 7/55

https://www.youtube.com/watch?v=8me0juJCpWM&t=40s

https://www.bnext.com.tw/article/82704/how-to-vibe-coding-2025
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軟體外觀 (Windows) 8/55
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CRAN: The Comprehensive R Archive Network 

repos="https://cran.csie.ntu.edu.tw/"
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R軟體下載

https://cran.csie.ntu.edu.tw/bin/windows/base/R-4.2.2-win.exe
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軟體安裝; 啟動R
注意: R軟體安裝目錄，使用者目錄、R套件安裝目錄的路徑
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想把中文介面改成英文介面

加入
LANGUAGE=en
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喜好設定
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R 選單
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寫程式及執行

程式存檔
(myRcode.R)

(1) 執行程式

(3) 利用source 
執行程式

> source(“myRcode.R”)

注意工作目
錄及print

(2) 執行程式
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R相關檔案副檔名
 .R：標準 R 程式碼檔案
 .Rhistory：指令操作紀錄檔
 .Rprofile：啟動時自動執行的設定檔
 .RData：整個工作環境（workspace）
 .rda / .Rda：多個 R 物件
 .rds：單一 R 物件（資料交換常用）
 .tar.gz：Linux/Unix R 套件壓縮檔
 .zip：Windows R 套件壓縮檔
 .dll / .so：編譯後的函式庫
 .Rmd：R Markdown 文件
 .Rnw：Sweave（R + LaTeX 文件）
 .Renviron：R 環境變數設定檔
 .Rproj：RStudio 專案檔
 .Rd：R 套件文件檔（help）
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安裝R套件 (RGui選單)
 Packages => Install package(s) => CRAN mirror => installr, rgl, 

scatterplot3d (按Ctrl可多重選取) => OK
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安裝R套件 (指令方式)

Automatically load packages in the Startup of R:
• call .First() in the Rprofile file.
• 編輯檔案(Windows) C:\Program Files\R\R-

3.3.1\library\base\Rprofile

.First <- function(){
cat("\n   Welcome to R!\n\n")
require(rgl)

}

> setRepositories()
> chooseCRANmirror()
> install.packages("rgl") # 安裝套件
> library(rgl) # 載入套件
> # same as > library("rgl")
> detach("package:rgl", unload=TRUE) # 卸載套件
> remove.packages("rgl") # 移除套件
> .libPaths() # 列出library安裝目錄

> # 指定repositories
> install.packages("rgl", repos = "http://cran.csie.ntu.edu.tw")

> options(repos="http://cran.csie.ntu.edu.tw")
> pks <- c("rgl", "ggplot2", "maps", "e1071")
> install.packages(pks) 
> lapply(pks, library, character.only = TRUE)

> # 安裝 BioC 的套件
> # setRepositories(graphics = F, ind = 2)
> # options("repos")
> source("https://bioconductor.org/biocLite.R")
> biocLite("EBImage")
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安裝R套件 (RStudio選單) 19/55
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安裝R套件常見問題

Why mac OS failed to install rgl: rgl package needs X11 to show its 3D plots. 
(1) Download/install XQuartz https://www.xquartz.org
(2) Check the library /usr/X11/lib/libGLU.1.dylib is loaded
(3) install.packages("rgl")

Installing R on OS X
https://www.r-bloggers.com/installing-r-on-os-x/
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library 和 require的差別
 狀況(1): 載入已安裝的套件，且 using the command outside of a 

function definition，則:  
 "require" or "library" 相同。

 狀況(2): 載入未安裝的套件，則: 
 library(foo): 程式停止with the message "Error in 

library(foo): there is no package called 'foo'." 
 require(foo): get a warning, but not an error. Your program will 

continue to run, only to crash later when you try to use a function 
from the library "foo"

 require(package) returns (invisibly) TRUE if the package is 
available
> # install "package" if it doesn’t exist, and then load it.
> if (!require(package)) install.packages("package")
> library(package)

21/55



https://hmwu.idv.tw

CRAN Task Views
https://cran.r-project.org/web/views/

> install.packages("ctv")
> library(ctv)
> 
> available.views()

CRAN Task Views
---------------
Name: Bayesian
Topic: Bayesian Inference
Maintainer: Jong Hee Park
Repository: https://cran.fhcrc.org
...
> ## install MachineLearning view
> install.views("MachineLearning")
> ## only with core packages
> install.views("MachineLearning", 
coreOnly = TRUE)
> ## update MachineLearning view
> update.views("MachineLearning")

What is the difference between require() and 
library()? Not much difference in everyday work. 
require is used inside functions, as it outputs a warning 
and continues if the package is not found, whereas library
will throw an error.
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Popular Packages
• Top 25 R Packages (You Need To Learn In 2024) | R-bloggers

• Top 15 R Libraries for Data Science in 2023
https://www.knowledgehut.com/blog/data-science/top-r-libraries-for-data-science
dplyr, tidyr, readr, stringr, lubridate, jsonlite, Shiny, tseries, Prophet, RColorBrewer, 
githubinstall, ggmap, sqldf, caret 

• Quick list of useful R packages
https://support.posit.co/hc/en-us/articles/201057987-Quick-list-of-useful-R-packages
Categories: To Fload data, To manipulate data, To visualize data, To model data, To report 
results, For Spatial data, For Time Series and Financial data, To write high performance R 
code, To work with the web, To write your own R packages
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https://github.com/qinwf/awesome-R

https://github.com/qinwf/awesome-R
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R Related Project

http://www.bioconductor.org

Related Projects
https://www.r-project.org/other-projects.html

• Bioconductor: Bioinformatics with R
http://www.bioconductor.org
• Rgeo: Spatial Statistics with R
https://geodacenter.asu.edu/projects/rsp
• Robust Statistics with R
http://www.statistik.tuwien.ac.at/rsr/
• Rmetrics: Financial Market Analysis with R
http://www.rmetrics.org
• Omegahat: Distributed Statistical Computing
http://www.omegahat.org
• Graphical User Interfaces for R
http://www.sciviews.org/_rgui/
• ESS: Emacs speaks Statistics
http://ess.R-project.org/
• R for Mediawiki
http://mars.wiwi.hu-berlin.de/mediawiki/sk/index.php/R_Extension_for_MediaWiki
• PowerShell R Interop Cmdlet
http://powershellrinterop.codeplex.com
• TANGO/ALGENCAN
http://www.ime.usp.br/~egbirgin/tango/
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說明手冊 (Help Manuals) 26/55
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求助範例
> help.search("t test")
> ?t.test

> help(solve)
> ?solve
> help("[[")
> help.start()
> ?help

?package.name
?package.name::function.name
apropos("norm") #search all function names for the "norm" key

NOTE:
> ?’if’
> ?Control
> ?’while’

> ?’%*%’
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求助範例 (conti.)

語法

參數

回傳值

範例

說明
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Search R
http://www.rdocumentation.org/ RSeek: 

https://rseek.org/

pkgsearch: Search and Query CRAN R 
Packages
https://cran.r-project.org/web/packages/pkgsearch/index.html
# ps() is an alias to pkg_search()
> install.packages("pkgsearch")
> library(pkgsearch)
> ps("survival")
> ps("networks")
> ps("visualization")
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> demo()

> demo(graphics)

demo(package = .packages(all.available = TRUE))

> library(rgl)
> demo(rgl)
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演示程式碼 (Demo Code) 31/55
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R程式IDE編輯器: RStudio

IDE: integrated development environment

Download RStudio Desktop
https://posit.co/
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客制化環境
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Tools => Global Options... 34/55
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新增專案及R程式檔
 File => New Project... => New Directory => Empty Project => 

Create Project

File => New File => R Script
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執行程式

以鍵盤選取程式碼: 
配合Home, End, Shift, 上下左右鍵

執行: Ctrl + Enter 或 Ctrl + R
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安排RStudio 專案目錄結構

制作一R套件的目錄結構
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RStudio 常用快速鍵 (Windows)

控制台(Console)
 游標移動到控制台 (Move cursor to Console): Ctrl+2
 清除控制台 (Clear console): Ctrl+L
 移動游標到行首 (Move cursor to beginning of line): Home
 移動游標到行尾 (Move cursor to end of line): End
 調出歷史指令 (Navigate command history): 上箭頭/下箭頭
 彈出歷史指令 (Popup command history): Ctrl+上箭頭
 中斷正在執行的指令 (Interrupt currently executing command): Esc

原始碼編輯區(Source)
 游標移動到原始檔編輯區 (Move cursor to Source Editor): Ctrl+1
 存檔 (Save active document): Ctrl+S
 關閉當前檔案 (Close active document): Ctrl+W
 執行當前行或者選擇的行 (Run current line/selection): Ctrl+Enter
 執行當前檔 (Run current document): Ctrl+Alt+R
 從檔案開頭執行到該行 (Run from document beginning to current line): Ctrl+Alt+B
 行縮排 (Reindent lines) : Ctrl+I
 註解(或消除)當前行或者所選程式碼 (Comment/uncomment current line/selection): Ctrl+Shift+C
 跳轉到配對的括弧 (Jump to Matching Brace/Parentheses): Ctrl+P
 刪除行 (Delete Line): Ctrl+D
 選擇 (Select): Shift+箭頭

一般
 尋找和替換 (Find and Replace): Ctrl+F; 尋找上一個 (Find Previous): Shift+F3; 尋找下一個(Find Next): F3
 上一步 (Undo ): Ctrl+Z; 剪下 (Cut): Ctrl+X; 複制 (Copy): Ctrl+C; 貼上 (Paste): Ctrl+V; 全選 (Select All): Ctrl+A

RStudio 0.99.893
C:\Program Files\RStudio\www\docs\keyboard.htm

RStudio，重新載入R:
選單: Session => Restart R
快速鍵: ctrl + shift + F10 
指令: > .rs.restartR()
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RStudio Help 39/55
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Posit Cheatsheets

 Sparklyr Cheat Sheet
 R Markdown Cheat Sheet
 RStudio IDE Cheat Sheet
 Shiny Cheat Sheet
 Data Visualization Cheat Sheet
 Package Development Cheat 

Sheet
 Data Wrangling Cheat Sheet
 R Markdown Reference Guide

 Contributed Cheatsheets
 Base R
 Advanced R
 Regular Expressions
 How big is your graph? (base 

R graphics)

https://posit.co/resources/cheatsheets/
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R Packages Developed by RStudio
https://posit.co/products/open-source/rpackages/

Analyze and explore 

Communicate and interact

Model and predict 

Connect and 
Integrate
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更新R軟體及R套件
 安裝R套件
 利用installr套件更新R軟體及R套件

> update.packages(checkBuilt=TRUE, ask=FALSE) 
 RGui => Packages => Update packages
 RStudio => Tools => Check for Package Updates...

Note: 先暫時不移除舊版的R及套件!

> setRepositories() 
--- Please select repositories for use in this 
session ---
1: + CRAN
2:   BioC software
3:   BioC annotation
4:   BioC experiment
5:   BioC extra
6:   CRAN (extras)
7:   Omegahat
8:   R-Forge
9:   rforge.net

Enter one or more numbers separated by 
spaces, or an empty line to cancel
1: 2

> update.packages("rlang")
> uninstall.packages("rlang")
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利用installr套件更新R軟體
> library(installr)
> installr() 

> sessionInfo() 
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學習資源

 博客來: https://www.books.com.tw
 Amazon
 Google
 Youtube
 https://stackoverflow.com/
 R-bloggers: https://www.r-bloggers.com/
 RDataMining.com: R and Data Mining: 

http://www.rdatamining.com/
 中華R軟體學會?

中華R軟體研發暨應用協會?
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R-bloggers，R Cheatsheet
https://www.r-bloggers.com

R Cheatsheet:
https://pyoflife.com/wp-content/uploads/2022/01/R-Cheatsheet-.pdf
https://www.rforecology.com/uploads/The_essential_R_Cheatsheet_v1_0.pdf
https://noeliagorod.com/2019/04/24/r-resources-free-courses-books-tutorials-cheat-sheets/
https://www.i3s.unice.fr/~malapert/R/pdf/base-r.pdf
https://rstudio.cloud/learn/cheat-sheets
https://www.rstudio.com/resources/cheatsheets/
https://www.i3s.unice.fr/~malapert/R/pdf/base-r.pdf
https://www.amelia.mn/Syntax-cheatsheet.pdf
https://cheatography.com/dipakk/cheat-sheets/r-basic/pdf/
https://cheatography.com/noella/cheat-sheets/introduction-to-package-r-sheet/pdf/
https://cheatography.com/bwaldo/cheat-sheets/r-subsetting/pdf/
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相關中文書目/查詢相關中文書目
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R/RStudio on the Phone 47/55
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Rcmdr: R Commander

https://cran.r-project.org/web/packages/Rcmdr/index.html
https://socialsciences.mcmaster.ca/jfox/Misc/Rcmdr/
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http://r.analyticflow.com/en/

© Ef-prime, Inc.

R Programming Support
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系統資訊/參數
> # R.Version: Version Information
> as.data.frame(R.Version())

platform   arch      os          system status major minor year month day svn.rev
1 x86_64-w64-mingw32 x86_64 mingw32 x86_64, mingw32            3   3.1 2016    06  21   70800

language               version.string         nickname
1        R R version 3.3.1 (2016-06-21) Bug in Your Hair
> 
> # Sys.info: Extract System and User Information
> Sys.info()
sysname release     version   nodename machine     login     user      effective_user

"Windows"  "8.1 x64" "build 9600" "HMWU-HOME"  "x86-64"   "userpc"   "userpc"  "userpc" 
> 
> # .Platform: Platform Specific Variables
> as.data.frame(.Platform)

OS.type file.sep dynlib.ext  GUI endian    pkgType path.sep r_arch
1 windows        /       .dll Rgui little win.binary        ;    x64
> 
> # .Machine {base}: Numerical Characteristics of the Machine
> as.data.frame(.Machine)

double.eps double.neg.eps   double.xmin   double.xmax double.base double.digits
1 2.220446e-16   1.110223e-16 2.225074e-308 1.797693e+308           2            53

double.rounding double.guard double.ulp.digits double.neg.ulp.digits double.exponent
1               5            0               -52                   -53              11

double.min.exp double.max.exp integer.max sizeof.long sizeof.longlong sizeof.longdouble
1          -1022           1024  2147483647           4               8                16

sizeof.pointer
1              8
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ChatGPT for R, or in RStudio 51/55

https://cran.r-project.org/web/packages/chattr/index.html

https://www.youtube.com/watch?v=AvRPsxnqzAM

https://cran.r-project.org/web/packages/gptr/readme/README.html

8 ChatGPT packages for R
https://www.infoworld.com/article/2338386/8-chatgpt-tools-for-r-programming.html
air, TheOpenAIR, RTutor, CodeLingo, askgpt, gptstudio, gpttools, gptchatteR

https://chatgpt.com/g/g-WUWF2eO0b-analysis-with-r
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sessionInfo()
> sessionInfo()
R version 4.2.2 (2022-10-31 ucrt)
Platform: x86_64-w64-mingw32/x64 (64-bit)
Running under: Windows 10 x64 (build 19044)

Matrix products: default

locale:
[1] LC_COLLATE=Chinese (Traditional)_Taiwan.utf8 
[2] LC_CTYPE=Chinese (Traditional)_Taiwan.utf8   
[3] LC_MONETARY=Chinese (Traditional)_Taiwan.utf8
[4] LC_NUMERIC=C                                 
[5] LC_TIME=Chinese (Traditional)_Taiwan.utf8    

attached base packages:
[1] stats     graphics  grDevices utils     
datasets  methods   base     

loaded via a namespace (and not attached):
[1] compiler_4.2.2 tools_4.2.2 

> RStudio.Version()
$citation
...

$version
[1] '2022.7.2.576'

# 查詢套件版本
> packageVersion("rlang")
[1] ‘0.4.5’

52/55

> # 查詢所有套件安裝路徑: 
> .libPaths()
[1] "C:/Users/hanmi/AppData/Local/R/win-library/4.5"
[2] "C:/Program Files/R/R-4.5.0/library"            
> 
> # 查詢特定套件的安裝目錄:
> system.file(package = "ggplot2")
[1] "C:/Users/hanmi/AppData/Local/R/win-library/4.5/ggplot2"
> 
> # 查詢所有已安裝的套件清單與路徑:
> # installed.packages()
> installed.packages()[, c("Package", "LibPath")]

Package          LibPath                                         
abind          "abind"          "C:/Users/hanmi/AppData/Local/R/win-library/4.5"
admisc         "admisc"         "C:/Users/hanmi/AppData/Local/R/win-library/4.5"
arm            "arm"            "C:/Users/hanmi/AppData/Local/R/win-library/4.5"
...
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> iris
The Most Frequently Used Data Set

UCI Machine Learning Repository
https://archive.ics.uci.edu/ml/

• StatLib: http://lib.stat.cmu.edu/
• 政府資料開放平台

http://data.gov.tw/
• 開放資料Open Data

http://www.opendata.tw/

2014 IASC Data Analysis Competition: http://www.iasc-isi.org/node/227
- World Bank - http://data.worldbank.org
- United Nations - http://www.un.org/en/databases/#stats
- World Health Organization - http://www.who.int/research/en/

The sepal length, sepal width, petal length, and 
petal width are measured in centimeters on 50 
iris specimens from each of three species, Iris 
setosa, I. versicolor, and I. virginica. Fisher (1936)
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RStudio 套件安裝問題 (1)

 My favorite RStudio tips and tricks
http://datacornering.com/my-favorite-rstudio-tips-and-tricks/?fbclid=IwAR2ZK9Fu3Q5j_wUQVo-tFuX0lxP4Zp2TwcfWKXHyV2R-C6EIgG1Gn-t3uJg

套件安裝問題，可能的解決方法:
 (1) 以「系統管理者員身份執行」開啟RStudio。
 (2) 改變R套件安裝資料夾「.libPaths」
https://www.twblogs.net/a/5cc0edfcbd9eee397113dede
 (3) 解決RStudio不支持Windows系统中文用户名問題
https://blog.csdn.net/qq_16146103/article/details/105445198
 (4) win10用户名為中文導致RStudio繪圖錯誤的解決方法
https://www.cnblogs.com/yanjiamin/p/12064048.html
 (5) Windows中文使用者與RStudio的環境變數調校
http://shorturl.at/AMNQ9
 (6) 解決RStudio中的亂碼
https://itw01.com/5XYZENB.html
 (7) 如何更改R的預設語系
https://psmethods.postach.io/post/ru-he-geng-gai-rde-yu-she-yu-xi

中文帳戶名問題

# 列出已安裝套件 ? installed.packages
mypks <- as.data.frame(installed.packages()[, 1:3])
mypks

中文路徑名問題
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RStudio 套件安裝問題 (2)
> install.packages("gridExtra")

將程式套件安載入 ‘C:/Users/User/Documents/R/win-library/4.1’
(因為 ‘lib’ 沒有被指定)
Warning in install.packages :

'lib = "C:/Users/User/Documents/R/win-library/4.1"' is not writable
嘗試 URL 'https://cran.rstudio.com/bin/windows/contrib/4.1/gridExtra_2.3.zip'
Content type 'application/zip' length 1109407 bytes (1.1 MB)
downloaded 1.1 MB

Warning in install.packages :
無法建立目錄 'C:\Users\User\Documents\R\win-library\4.1\file2b905b04620' ，原因是 'No 

such file or directory'
Error in install.packages : unable to create temporary directory 
‘C:\Users\User\Documents\R\win-library\4.1\file2b905b04620’

點滑鼠右鍵選「內容」 取消「唯讀」，按確定。
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